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Getting Started 

 

Today we’ll be talking about Microsoft Excel at an intermediate level.  This class does require 

that you have basic Excel skills, such as those taught in our introductory class, and that you are 

comfortable using both the mouse and keyboard extensively.   

 

Topics we cover are: formulas/functions, filtering and sorting, and charts. 

 

Advanced formulas and functions   

 

Refresher: What are formulas and functions?  

In Excel, a formula is an equation to perform some sort of calculation in your worksheet.  It 

could contain any combination of numbers, cell references, mathematical operators, and 

functions.  They always start with an equals sign (=) so that Excel knows to “do” the contents of 

the cell, rather than displaying them. 

 

Sample formulas would include: 

=7-5+9   (Subtracts 5 from 7, then, adds 9 to the result.  The cell would display 11) 

=A2+B9 (Adds whatever number is in cell A2 to the number in cell B9 and displays the result) 

 

A function is a prewritten formula that you can include in your sheet, simply putting in the 

appropriate values.  You’ll find that a lot of the calculations you’ll want to do already have 

functions written that you make use of, and they are very helpful if making a lengthy calculation 

clearer.  They generally take the form of the function name, followed by the values/references in 

parentheses.     

 

Sample functions include: 

=SUM(C7:C22) (Adds together all the values in every cell from C7 through C22 and displays it) 

=AVERAGE(2,3,4,5,6)  (Finds the average of 2, 3, 4, 5, 6 and displays it) 

 

Remember: 

- Formulas and functions always start with an equals sign (=)  

- Use commas to separate values or cell references use individual cells/values (C2, D4) 

- Use colons to separate values/cell references to cover a range of cells/values (C2:C12) 

- Functions always take the format:  =FunctionName(values,separated:appropriately) 

 (equals sign, function name, opening parenthesis, values, closing parenthesis) 

-  Copying formulas/functions from one location to another will update to reflect the new 

    cell references (special case: absolute cell references) 

- You can “nest” formulas and functions inside each other 
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Using the Function Wizard 

You always have the option of typing in a formula or function, assuming you can remember the 

name and the proper format for entering it.  Excel also includes a function wizard to make them 

easier to create.  First, choose the cell where you wish to enter the function.  Then, to start the 

wizard, click the Formulas ribbon and choose Insert Function. 

 

A new window will come up, prompting you to choose the type of function you want to use.  

The ones you use most often will show up automatically.  Otherwise, you can choose the 

category of functions (“All” will show you everything that is available) to get a more complete 

listing.  Highlight the function you wish to use and click OK. 

 

 
 

Excel will then give you a window where you can type the numbers, range of numbers, cells, etc, 

to perform the calculation on.  It will also show you the formula result as you enter each new 

piece of data.  (The precise layout of this screen may vary for different functions).  When you’ve 

entered all your data, click OK to return to the spreadsheet. 
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Example One: 

On your desktop should be a file called “IntermediateExcel.xls”.  (Those of you who took our 

Introductory class will find some of the examples familiar!)  For practice, do the following 

functions on the worksheet titled “January”: 

 

In cell E25, enter the formula to automatically add up everything in column E, rows 3 through 

18.  (Function: SUM) Copy that function over to F25.   This will give you totals of all your 

“household expenses” in their actual cost (column E), and their budgeted amount (column F).   

 

Now, in cell G25, write the function to show the difference between what you expected to spend 

and actually spent.  (Hint: use subtraction)  Use cell references to write the function. 

 

Enter two new expenses in rows 19 and 20.  Use the autofill to complete the next check numbers 

and dates. Use any category for the expenses you’d like, and make up the payee, amounts, and 

budgeted amounts (make the actual and budgeted amounts different, though).     

 

Watch what happens to the totals in E25 and F25, and the difference in G25.  

 

Example Two: 

This one’s a little more complex.  We’re going to nest functions inside of functions.  Let’s 

pretend that you don’t care if you’re over or under budget for the month – you just want to know 

how much you were off.  Since you already know the difference (you calculated that in G25 in 

the previous example), we will make use of the Absolute Value function (ABS). 

 

Click into cell G25 to make it active, then go up to the formula bar to edit the function.  Use the 

formula you already entered (F25-E25) as the arguments to the function ABS.  The end result 

should look like:     =ABS(F25-E25) 
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Relative, Absolute, and Mixed Cell References 

 

There are two types of cell references in Excel: absolute and relative.  When you are creating, 

copying, and moving formulas, it is important to know which type of cell reference to use, as this 

impacts how your formula will act if relocated.   

 

Absolute cell references use the exact address of a cell, regardless of the position of the 

formula’s cell.  If you look at the cell reference, it would contain dollar signs ($A$1). 

 

Relative cell references means that the cell’s address is based on the relative position of the cell 

that contains the formula and the cell that’s being referred to.  If you copy the formula, the 

reference will automatically adjust.  These contain the cell location without dollar signs (A1). 

 

You can also have mixed cell references, where either the row OR the column is absolute, but 

the other relative. 

 

Identify the cell references types of the following: 

 

D9      

$C$27      

E$5      

$A16      

 

In your sample workbook, switch to the worksheet titled “CellReferences”.  

  

Create a sum function in A8 that adds up column A (rows 1-6) using absolute cell references.  

Copy that function to B8.  What happens? 

 

Now create a sum function in D8 that adds up column D (rows 1-6) using relative cell references.  

Copy that function to E8.  What happens?   

 

 

Filtering, Sorting  

Excel allows you to filter and sort groups of data, whether it is comprised of words or numbers.  

Filtering only shows you data that meets criteria you set (for example, expenses more than 

$200), while sorting lets you reorder data into a way that makes it more meaningful (alphabetize 

a list of names). 

 

Using Auto Filtering 

The auto filter feature means that you are allowing the software to predict what types of 

information you’d like to filter.  It works by looking at all the values in a column and offering 

them to you as an option.  When you use the auto-filter, you are able to restrict your list to 

showing only those items whose value match the one set in the filter.  This includes an option to 

show all entries that have a blank in a particular column, or all non-blanks. 

 



Page 6 of 12 

To enable a filter, first select the range of cells you want to filter.  If you have column headers, 

include them as well.  Then click Data ribbon -> Filter.  Dropdown boxes will be created that 

give you the values for each column; to filter for a particular value, simply select it from the list. 

 

Change to the worksheet called “Filtering”.  There’s a list of children’s name, ages, and the sport 

they play.  Pretend it’s a class list, and you want to know which of your students play soccer so 

you can make a bulletin board at the beginning of the season.   

 

Select all of the cells (A1:D13).  Turn on the auto filter and click the drop-down box that appears 

in the “Sport” column. 

 
 

To restrict this to only Soccer players, uncheck all but “Soccer”.  The spreadsheet will hide all 

the other values.   

 

To show all the entries, simply choose the dropdown again and choose the (Select All) option.  

You can also use multiple auto filters at the same time; showing, for example, all the Female 

soccer players.  Simply apply one filter, then the other.   

 

Practice using filters to do the following (remember to clear them in between): 

Show only male students  

Show all softball players 

Show all 11 year old female students. 

 

You can turn off all filters by going to the Data ribbon and un-checking Filter. 

 

 

Custom filtering 

There is also a subset of the auto filters that allows you to create “custom” filters.  This gives you 

options beyond simple matching, such as finding values greater or less than a specified value. 
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You begin by enabling the auto filter as before.  When you choose the dropdown box, choose the 

(Number Filter) (or Text Filters, if applicable) option, rather than a specific value.  Then chose 

Custom Filter… 

 

 
 

Select the comparison type you wish to use (equals, greater than, etc), and the value you want to 

compare against.  Click OK to return to the worksheet and apply the filter. 

 

You can also use two criteria to further filter your information by putting in a comparison type 

and value in the second filter box.  Select “and” if you only want to see records that meet both 

criteria.  Select “or” if you want to see records that meet either criteria. 

 

Set up Custom AutoFilters to do the following:   

Show everyone older than 11 (age greater than 11) 

Show everyone who plays either baseball or softball 

 

Quick sorting 

Sorting allows you to put the records you have into a particular order, usually alphabetically or in 

ascending/descending numerical order.  A quick sort is a simple sort (using only one column to 

sort), and is generally applied to an entire spreadsheet. 

 

To do a quick sort, click any cell in the column you wish to sort by.  Then click the appropriate 

icon (shown below) to apply the sort.  The left icon (with the “A” on top) will sort in ascending 

order (A-B-C, 1-2-3), while the right one (with the “Z” on top) will sort in descending order (Z-

Y-Z, 6-5-4). 

 

 
 

Do the following quick sorts in the worksheet named “Filtering”: 

Sort the students youngest to oldest 

Sort the students by first name, reverse alphabetically (Adam should be at the bottom) 
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Custom sorting 

 

Beyond the quick sort, you can also apply more advanced sorting techniques, such as sorting by 

multiple columns.  (For example, if you had a column with last names and first names, you could 

sort alphabetically by the last name, then the first name).   

 

To use this sort function, begin by selecting the cells that contain the data you want to sort (if 

you do not make a selection, the sort will apply to everything in the spreadsheet).   Start the sort 

tool by going to the Data ribbon and choosing Sort.  The sort configuration window will appear. 

 
 

Choose which column(s) you wish to sort by, and whether you want to use the ascending or 

descending sort for each.  If your selected area contains a header row (labels for the columns), 

select the option for “my data has headers” – otherwise the headers will get sorted with your 

other data.  When you’re happy with your selection, click OK to apply the sort. 

 

There are a few additional options under the “Options” button of the sort configuration window, 

including the setting to sort by rows instead of columns.  Most of the time, however, you will not 

need to change any settings there. 

 

On the worksheet “Filtering”, do the following sorts: 

Age youngest to oldest, and gender alphabetically 

Sport in reverse alphabetical order, name in normal alphabetical order 

 

 

 

Charts  

Excel includes functions to create charts and graphs of the data you’ve entered.  You can create 

all of the standard types of charts and graphs (such as bar, line, pie, scatter plot), and control the 

specific settings for what data they show, how they look, and where they are in your workbook. 
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Use the “Charts” worksheet and make the following charts (each on a separate worksheet): 

 

A pie chart showing each month’s percentage of the total annual sales 

 

Using the chart wizard 

To begin, you must have the data created within your Excel spreadsheet.  It is also recommended 

that you give some early thought to what type of chart you want (bar vs. pie, etc).  There is a 

chart wizard that will walk you through the four steps of inserting a chart.   

 

 

1.  First select your data  (entire 

columns: January/Actual)   

 

 

 

 

 

2. Click the:  Insert Tab 

3. Select:  Pie – 2 Dimensional. 

 

 

 

 

 

Your chart should look like this.  Notice though that the 

months November and December are not displayed.  You 

must expand your chart by placing your pointer on one of 

the corners to get the double arrow.  4. At that 

point…click and drag it to enlarge.  *a pie chart is only 1 

dimensional, resulting in the first series of data only, 

which in our case are the actual sales numbers. 

 

 

 

 

 

OK…now…let’s add a Chart Title to our pie chart.  5. Click the:  Layout tab – select: Chart 

Title -   and :Above Chart.  Now…highlight the text and type: Monthly Annual Sales.  You can 

further modify your chart by selecting the Design tab for: Change Chart Type, Styles and/or Save 

as Template. 

 

 

 

 

 

 

2. 3.

. 

5.

. 

Please note: If you 

click off the chart 

the Design tab 

disappears, making 

it inactive. 

4.

. 
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Spend a few minutes making any sort of changes you’d like to the pie chart you created 

previously.  -Sample ideas would include:  Removing a month from the pie chart’s data series. 

Watch what happens!  

 

6.  OK…now let’s change the  Chart Type…by Selecting: Change Chart Type within the Design    

      tab and clicking on: Clustered Column. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When changing chart type, it only reveals the first series of information (Actual).  So to fix this, 

click on chart (to reveal the Chart Tools Design Tab), select the (7) Select Data option, and      

(8) highlight headers/columns: Month, Actual & Goal.  During this selection mode, the bar graph 

will automatically display these changes.  Click the (9) “OK” option on the Select Data Source 

dialog box.  

 

 

 

 

 

 

 

 

 

 

 

 

 

6.

. 

7.

. 

8.

. 
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Column chart showing monthly sales actual numbers next to goal numbers, including a legend to 

show both sale numbers. 

 

 

 

 

 

 

 

 

 

 

 

 

To move your chart to its own page, click the Design ribbon, then Move Chart…to New sheet 

 

            
 

 

 

 

 

OK…let’s try this…click on current chart, then…press the Delete key.  Highlight the Month and 

Actual columns, select the Insert tab, click on: Line chart type, followed by Line with Markers 

chart.   Scatter plot chart with non-smoothed lines showing the goals by month, with the month 

name as a data label 
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Example of a Line with Markers Chart 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Modifying a chart 

Once you have created a chart, you are able to made changes to it.  The easiest way is to single-

click on the part of the chart you wish to change (data series, labels, etc), then use the Design, 

Layout, or Format ribbons   

 

Once you’ve selected the item you want to change, you will see the same screens as you did 

originally in the chart wizard.  Simply select the appropriate settings and click Finish to 

complete the changes. 
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